CAN 3SUS EXTENSION

TurboCorse.at
Electronics



Table of Contents

Functions of the eXtension BOard ..........cceoiiiioiiiiiie e s 3
Terminal and CONNECLON IaYOUL .....ccceeee et e rrre e e e e e e e et are e e e e e eessansraaeeeeaeeennnnes 4
TEIMINAL XLt oottt ettt sb e st e e bt e e s a bt e s bt e e s b e e e abeeeamseesabeeesaseeenbeeeneeesareeennneas 4
L00o T o] o T=Tot (o] B0 0 PP PPPPRTRPPRT 4
Electrical connection of the board .........c..eouieiiiiiiiiei e 5
oA TR U o o) 1Y USSP 5
OULPULS L4 e e e e e e e e e e e e e e e 5
F AN F=1 Lo} =T o o U PSRRI 5
D F=q 1= I o oYU €3S PEPPRE 5
B =T 2o Tolo U1 ] =TSSP 6
AN DUS: ettt ettt b e bt e she e s et e bt e bt e b e e e neesne e et e e teereen 7
GBI INTEITACE: .ttt ettt ettt st b e bt sme et ne e 7
Y1 ] - 1Y SRR 8
Can BUS BroadCast ... ..coiiieeie e st e e e sare e s re e e sareeeas 9
Led’s and tactile SWItCRES......ooviiiiee et 10
L€ (<1< o PP PP 10
2=Tc U PP S TO RO PPTRURTRTROTRPIN 10
Y EIIOW . <ttt sttt b e s b et e he e e s b e e e he e e eare e e ne e e sabeeebeeeanreesreeennneas 10
SWITCR L2 ettt et st ettt e a e e s bt e e s bt e e s at e e s bt e e sa b e e e be e e ant e e s be e e aneeeenreesneeesareeeas 10
Offsets for can bus connection to the megasquirt (2-3) ......ccoeciiieieiiie e 11
(0o} 1= (U= 1A oY T 1 K SRR 12
(0o} iT={U T 1A oY T Y/ K3 TSRS 13
Configuration to act as a can device within tuner studio.........ccceeevcieiiiiiiiie e 14
(U1 Te EY oI 110 0 01T 2= U URPU 15
Restore default CONfIGUIAtioN .......ooo i e e e e e e e e e abraee e e e e e e e ennes 16
LAV 1Y [ L PSR PRUR PRI 17

©TurboCorse



Functions of the extension board

The TurboCorse can bus extension board serves as I/0 extension for the Megasquirt (2-3)
engine management system.

If the extension board is fully assembled it has the following functions:

e 8x Thermocouple type k

e 4x 0-5v Sensor or ntc temp sensor. (selectable through soldering jumper)
* 4x NPN Mosfet output 3A per channel

e 2x Frequency or normally input. (max voltage is 5v)

e 2x Tactile switches

e 3x Led for status information’s

* Lcdinterface

e TTL (USB, BLUETOOTH) interface 115200 Baud

e Can bus interface 500k Baud (terminating resistor through jumper selectable)
e  TWlinterface

* ISP interface

e JTAG interface

Megasquirt is a registered trademark from B&G
Tuner Studio is a registered trademark from Efi Analytics
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Terminal and connector lavout

Terminal X1:

Pinout terminal X1. (orange or gray one)
You will have always 2 gnd wires within one terminal. Therefore we have 12 terminals for 8 sensors.

Terminal 1 Thermocouple 1 +
Terminal 2 Thermocouple 1/ 2-
Terminal 3 Thermocouple 2 +
Terminal 4 Thermocouple 3 +
Terminal 5 Thermocouple 3/ 4 -
Terminal 6 Thermocouple 4 +
Terminal 7 Thermocouple 5 +
Terminal 8 Thermocouple 5/ 6 -
Terminal 9 Thermocouple 6 +
Terminal 10 Thermocouple 7 +
Terminal 11 Thermocouple 7 / 8 —
Terminal 12 Thermocouple 8 +
Table 1

Connector X2:

Pinout connector X2. (frontal connector)
You will find the needed connector and crimp terminals within the package.

Al GndOut3/4 C1 AnalogIn 4 E1l Analog In 2
A2 Out 4 c2 Digital In 2 E2 Can Gnd
A3 Out 3 c Digital In 1 E3 CanH

B1 GndOutl1/2 D1 AnalogIn 3 F1 Analogin 1
B2 Out 2 D2 +5V Out F2 Gnd In

B3 Out1l D3 CanlL F3 +12VIn
Table 2
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Electrical connection of the board

Power supply:

Connect the pins F2 / F3 (Gnd / +12V) of the X2 connector (the black one) with a 3A fuse to the key
switch power supply. Maximum allowed input voltage is around 17V. If the power supply is okay, the
green led should be on.

Outputs 1-4:

If you will use the outputs 1-4 it’s needed to connect the A1, B1 pins to GND. The NPN Mosfet’s
switch to corresponding GND pin. The internal GND is not connected to the outputs.
The maximum load for each output is around 3A.

Analog inputs:

The analog inputs 1-4 can be used for 0-5V or NTC sensor inputs

If the input is used for 0-5V signals the solder jumper must be open.

If you will connect ntc sensors close the solder jumper for the specific input. This will attach the 2200
ohm bias resistor.

To calibrate the ntc sensor you can use the same function as for the Megasquirt.

This is only possible if you are connected to the serial port of the board. It is not possible if you use
can pass through.

You will find the function under Tools->Calibrate Thermistor Tables.

Digital inputs:

The digital inputs 1-2 can be used as generic inputs. Maximum voltage is 5V.
You can use them for frequency signal. The frequency in Hz is recorded.

You can use input 1 for a switch to change the page at the display.
The state from the inputs will be transmitted to the Megasquirt. (CANIN6 / CANIN7)
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Thermocouple:

The thermocouple’s (maximum 8) are connected at the terminal X1.
You will find the layout at table 1.

Push the white lever down, this will open the terminal and you can clamp the wire from the
thermocouple.

The wires from the thermocouple go through the nozzle at the back from the housing.

Only typ k sensors are supported. If you will use another type let me know. It’s needed to fit another
chip.

The temperature range which the board will detect goes from 0°C to 1023°C.

The board detects automatically how many sensors are attached.
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Can bus:

The pins E2, E3 are for can bus connection.

There is also a termination resistor located at the board. (JP1)

If you connect the two pins together the 1200hm resistor is terminating the can bus.

This is needed at the first and the last device at the can bus.

The can bus speed is 500kbaud. All messages will be sent with this speed.

The default ID for communication within the Megasquirt can bus system is 12.

It is recommended to twist the CanH and CanlL wires together

If you use the extension board with the Megasquirt 2, 3 be sure that the internal can bus connection

is made.
JS6 (CanH) goes to SPR1 and JS8 (CanL) goes to SPR2

Serielle interface:

You can use the serial TTL interface to connect the board with Tuner Studio.
During startup the board sends the actual firmware signature and version.
You need some kind of TTL<->RS232 or TTL<->USB converter.

Connection settings are 38400 Baud, 8 Data Bits and 2 Stop Bits.
(From pcb version v1.1.1 onwards 115200 baud are used.)
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Display:
It is possible to connect a 16x2 LCD display to the board.

The board requests the data from the Megasquirt and shows them at the display.
You have 5 pages with 4 values per page.

If the ,,BarGraph” function is enabled there is another page, so you have a maximum of 6 pages.
At page 6 you have only RPM and Lambda. And the bar graph for the RPM.

If the ,ShiftRpm*“ function is enabled the background light from the display will flash if you exceed
the RPM threshold.

Connect the display to the LCD connector. In the table below you can find the layout.

1 +5V VCC (2) white
2 GND GND (1), R/W(5) braun
3 RS RS (4) green
4 E E (6) yellow
5 D4 D4 (11) gray

6 D5 D5 (12) pink

7 D6 D6 (13) blue

8 D7 D7 (14) red

9 LED+ A (15) black
10 LED- K (16) purple
Table 3

Under certain circumantations a series resistor is needed for the backlight of the LCD
If no one is directly at the LCD you can fit one in R22 next to the LCD connector.

You can calculate the needed value with the following formula.
(Supply Voltage [v] — LCD Led Forward Voltage [v]) / Forward current [A]

The maximum current for the backlight is 30mA!!!

| have made a display adapter pcb. You can solder the Icd display to the pcb and connect the 10 way

connectors together.
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Can bus broadcast

Every 65ms a broadcast message stream is send to the can bus.
The message format is according CAN 2.0A 11 bit identifier.

Here you can see the layout of the broadcast messages.

B2U =  Big Endian (Motorola Format), 2 Bytes, Unsigned
B2S = Big Endian (Motorola Format), 2 Bytes, Signed

U= 1 Byte, Unsigned
760 0 B2U Thermocouple 1 [0..1023°C]
2 B2U Thermocouple 2 [0..1023°C]
4 B2U Thermocouple 3 [0..1023°C]
6 B2U Thermocouple 4 [0..1023°C]
761 0 B2U Thermocouple 5 [0..1023°C]
2 B2U Thermocouple 6 [0..1023°C]
4 B2U Thermocouple 7 [0..1023°C]
6 B2U Thermocouple 8 [0..1023°C]
762 0 B2U Analog In 1[0..1023]
2 B2U Analog In 2 [0..1023]
4 B2U Analog In 3 [0..1023]
6 B2U Analog In 4 [0..1023]
763 0 B2S Analog Temperature 1 [1/10°C]
2 B2S Analog Temperature 2 [1/10°C]
4 B2S Analog Temperature 3 [1/10°C]
6 B2S Analog Temperature 4 [1/10°C]
764 0 B2U Frequency input 2 [Hz]
2 B2U Frequency input 2 [Hz]
4 1U Runtime [0..255 H]
5 1U Runtime [0..59M]
6 1U Runtime [0..59S]
7 1U Output Status [Binary]
765 0 B2U Runtime [0..65535MS]
2 1U Input Status [Binary]
3 1U Active Thermocouples [Binary]
4 1U Thermocouple counter [0..7]
5 1U Analog counter [0..3]
6 B2U Main Loops per second
Table 4

©TurboCorse



Led’s and tactile switches

At the board there are 3 different LED’s every one with a special meaning.

Green:

The green one is on if the board has power supply.

Red:

The red one is blinking if the board is communication through the can bus.

If the can bus is not connected or the board didn’t get any answers or the board is the only device
attached to the can bus the board turn on the led after ~1s.

So if the red led is on it means no can bus connection / answer.

Yellow:

The yellow one changes the status every time a thermocouple channels is readed.
Every 125ms (8Hz) a thermocouple value is collected.

If the led flashes fast no thermocouple is reconized by the automatic detection algorithm. (20Hz)
Switch 1-2:

Status for switch 1 / 2 is forwarded to the MS as CANIN1 / CANIN2

You can use S1 to change the page at the LCD.

With S1 you can restore the standard config.

10
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Offsets for can bus connection to the megasquirt (2-3)

Here you can find the table offset fort he supported values
Standard canbus ID =12

B2U =  Big Endian (Motorola Format), 2 Bytes, Unsigned
B2S = Big Endian (Motorola Format), 2 Bytes, Signed

U= 1 Byte, Unsigned
2 0-39 B2U Display variables
40 S2uU Thermocouple 1 [0..1023°C]
42 S2u Thermocouple 2 [0..1023°C]
44 S2uU Thermocouple 3 [0..1023°C]
46 S2u Thermocouple 4 [0..1023°C]
48 S2uU Thermocouple 5 [0..1023°C]
50 S2u Thermocouple 6 [0..1023°C]
52 S2uU Thermocouple 7 [0..1023°C]
54 S2uU Thermocouple 8 [0..1023°C]
56 B2U Analog In 1 [0..1023]
58 B2U Analog In 2 [0..1023]
60 B2U Analog In 3 [0..1023]
62 B2U Analog In 4 [0..1023]
64 B2U Frequency input 1 [Hz]
66 B2U Frequency input 2 [Hz]
68 B2U Frequency input 1 Delta Count [Incements]
70 B2U Frequency input 2 Delta Count [Incements]
72 S2S Analog Temperature 1 [1/10°C]
74 S2S Analog Temperature 2 [1/10°C]
76 S2S Analog Temperature 3 [1/10°C]
78 S2S Analog Temperature 4 [1/10°C]
80 1U Output Status [Binary]
80.0 1U Out 1 (CANout 01)
80.1 1U Out 2 (CANout 02)
80.2 1U Out 3 (CANout 03)
80.3 1U Out 4 (CANout 04)
81 1U Input Status [Binary]
81.0 1U Switch S 1 (CANIN1)
81.1 1U Switch S2 CANIN2)
81.5 1U Input 1 (CANING)
81.6 1U Input 2 (CANIN7)
Table 5

11
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Configuration MS2

Standard config for MS2.

| Eile  Heip

| CAN Parameters
B MyCANID

i Master Enable

'@ Enable PWM Polling

* @ Remote CAN ID

‘0 Remote Table Number For PWM data ﬁ_E
'@ Remote Table Offset For PWM data(bytes) 54 5]
) Remote PWM Clock Frequency{MHz) I1_E

' Remote PWM Clock Prescale I1 E

CAN ADC Selection
CAN ADC Group On/OfF CAN Id

') Enable Ports Polling

i Remote CAN D

< i Remote Table Mumber For Ports Data

“@ Remote Table Offset For Ports Data(bytes) 80 5
i Remote Ports Direction I‘1 Input, 2 Cutputs | - |
"I Remote Port 1 Type IDigJ'taI (& signals) |v|
73 Remote Port 2 Type IDigJ'taI (8 signals) |v|
@ Remote Port 3 Type |Digital (8 signals) v
‘i@ Use For Remote On/Off Qutputs IRerr‘rote Port 1 |v|

Table Dffset
o 7)

‘@ CANADC 0-3 [Enable v ‘@ 2 H e | 2

(oytes) a0 HH

'@ CANADC 47 [Enable ~| ‘@ 2

H o8 k H /0 ones) e [

E‘ - Burn Close

12
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Configuration MS3

Standard config for MS3.

File Help
CAN Parameters

©TurboCorse

B MyCAN D o[ Digital ports |
" @ Master Enable |on E} '@ Remote CAN Id 2 H
' @ 29bit Megasquirt CAN Enable |On [v| /@ Table l2 =
* @ CAN baud rate (caution!) |5m]k |,.| i} Enable Input Port [Enable |v|
* @ Enable PWM Polling |16bit || 8 Ofset(bytes) a1 =
/@ Remote CAN Id [z [5 O EnavleOutputPor one v
'@ Remote Table NumberForPWh Data 2 [5] 7 Offsetioytes) B M
'@ Remote Table Offset For PWM Data(bstes) o4 |5
'8 Remote Clock{MHz) [T E] 8 Enable Pwh Outputs Disable v
'@ Remate Prescale [ K “8 Remotecanid i
' Remote Divider ﬁ_E k) 1_'3:1Ie" | =
il Ofset{bytes =
'@ Enable ADC Polling [Enable [v| @ Force Duty To 0-255 |Disable -]
CAN ADC selection |
I CAM ADC group on/off CAM Id Table Offset |
‘@ CANADC 1-4 |On [~ ‘@ m EHefF H@m B
CANADC 58 [On [+] ~ o EHe F He ® H i
CAN ADC 9-12 |On [~] I a— T
CAN ADC 13-16 |On =]l m B+ F H Ca—
CAN ADC 17-20 |OfF [~ = = =
CAN ADC 21-24 [OF [~ = =

A

[ g s -

T I wemeee— 3
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Configuration to act as a can device within tuner studio

Connect the io board as can device in TS.

Following steps are required:

Open your TS project.

Projekt Settings. File=>Vehicle Project>Project Properties, or by press CTRL + P.
Menu ,,CAN Devices”“.

With button ,+“ you can add a new device.

Fill in the device description .

Check ,,Disable Runtime Data“.

Under ,Connected Device” chose the can id. (Normally = 12)

Under ,,Device Configuration File” chose the ini file.

Click ,,0k“ to finish the settings.

TS restarts the project then you have a drop down list on the left menu bar

I Configuration [’Setﬁngs CAN Devices N

Projects Main Controller

Main Controller CANID [0 |w

Serial Protocol: |Fin11ware Default |v|
CAN Devices
[iio Board (can2) |
|
h|
I [¥]
Device Identifier (short}
] Device description |l/C Board
I [] Disable Runtime Data

: ___|Can Expander
)| Connected Device [ .- v

Device Configuration File:
L I‘IJdioF‘rojecis\.I'dSB Test EculprojectCiglCANZ ini

Configuration Settings

No settings of this type.

=
=

g
8

14
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Update firmware

You can update the firmware over serial. The io board has an bootloader.

If you have bluetooth installed you are the lucky guy and can go forward.
If not a RS232<->TTL or USB<->TTL cable is required.

Connect it to terminals RxD_S/ TxD_S/GND_S.
Install the jumper according the picture below.

Open TurboCorselLoader folder.

Within the folder there must be the desired hex file” don’t change the name.

Start ,,Firmware_Loader.bat”.
Fill in the com port for example “Com1” and press enter.

15
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Restore default configuration

You can restore the default settings bay following steps:

e Turn oft he io board
¢ Pess and hold button S1.

e Turnonio board, yellow and red led are on for about 500ms.

¢ Now you have restored the default settings.

16
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Revisions

V1.0

17.04.2019

First edition (translation form
german to english)

17
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